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License for use and distribution

WinLock is distributed as try-before-you-buy. This means:

1.

10.

All rights to WinLock are exclusively owned by the author - Crystal Office Systems.

Anyone may use this software during a test period of 30 days. Following this test period
of 30 days or less, if you wish to continue to use WinLock, you should purchase a
license.

Once registered, the user is granted a non-exclusive license to use WinLock on as many
computers as defined by the licensing terms according to the number of licenses
purchased, for any legal purpose. The registered WinLock software may not be rented
or leased, but may be permanently transferred, if the person receiving it agrees to terms
of this license. If the software is an update, the transfer must include the update and
all previous versions.

The WinLock evaluation version, may be freely distributed, with exceptions noted below,
provided the distribution package is not modified.

To register you must complete the online registration form and pay registration fee.

WinLock is licensing on a per-computer basis. One license is required for each computer
where software is installed. In case of diskless clients, one license per node is required.

WINLOCK IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR
DATA LOSS, DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE
USING OR MISUSING THIS SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile,
disassemble, otherwise reverse engineer, or transfer the licensed program, or any
subset of the licensed program, except as provided for in this agreement. Any such
unauthorized use shall result in immediate and automatic termination of this license and
may result in criminal and/or civil prosecution.

All rights not expressly granted here are reserved by Crystal Office Systems.

Installing and using WinLock signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove WinLock files from
your storage devices and cease to use the product.
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Chapter 1. Introduction

About WinLock

WinLock is a comprehensive security solution for personal or publicly accessible computers
running all versions of Windows from 2000 to Windows 10. It is a program that ensures that
only authorized people can access sensitive information on your computer.

With WinLock you can control how long others can use your computer. It runs from the system
tray and requires a password to gain access to the available settings. It loads automatically with
Windows and allows you to add an optional startup message, provide audio notification, and set
the time limit. Once that limit is reached, Windows is summarily shut down. You can toggle the
timer on and off from the tray. When enabled, there is no way around it without the proper
password.

WinLock also allows to disable Windows hot keys (such as Alt-Ctrl-Del, Alt-Tab, Ctrl-Esc, etc.),
lock Windows desktop, customize Start menu, hide Start button and Switch bar, and much
more...

Block Windows and Lock Files features allow to block virtually any application or any part of it
(window, popup message, dialog box), Explorer Windows (My Computer, Recycle Bin etc.), and
lock selected files. Restricted sites feature filters Internet content and prohibits access to
questionable websites.

Whether you're worried about coworkers going on the network and gaining unauthorized access
to your private files, or your kids messing up your work files, WinLock is a software-only
solution to your security needs.



WinLock is available in two editions: Standard and Professional. WinLock Professional offers
all features of the WinLock, plus several advanced security capabilities of interest to the
professional users. The advanced features of the Professional edition are:

Support for multi-user environment.

e Internet Explorer restrictions.

e Search through website for prohibited keywords.
e Guest password.

o USB key authentication.

¢ Webcam snapshots.

e Flexible removable drive restrictions.



Key features

System restrictions - disable command prompt, desktop, clipboard, control panel,
safe mode, and more...

Parental control - control how long your children can use the computer.
Restrict Start Menu - hide the selective Start menu items, block context menus.

Control Internet access - allow access only to the trusted sites only, and block all
others.

Software filter - block access to the downloaders, games, messaging clients, or CD
burners.

Kiosk mode - lockdown security for ATMs, terminals and public-access computers
(companies, schools, hotels, public agencies).

Installation blocking - prevent users from installing the software.

Instant Lock - hide any program or window on your screen with a simple hot key
combination.

Drives - hide your system and network drives in Windows Explorer.

Window blocking - block virtually any application or any part of it: window, popup
message, or dialog.

Screen capture - create snapshots of your screen or web camera at regular intervals.

Remote administration - apply restrictions, lock workstations and log user activities
via network.

Password generator - create highly secure passwords that are difficult to crack or
guess.

One-button protection - click one button to lock workstations the way you want.

Logging - monitor changes to the Windows shell and writes these changes to the log
file.

and more to explore and use...



Why choose WinLock?

e WinLock is suitable for a wide range of computer security tasks.
You can stop other users of your computer from peeking into your personal files. You
can allow specific users to run a program while denying it to others. You can allow users
to store their documents on removable drives, while preventing them from using
unauthorized programs on those drives.

e WinLock is easy to use.
WinLock sports one of the most intuitive user interfaces, that makes it easy to use by
both novice users and computer professionals.

e WinLock runs on a wide range of Windows platforms.
From Windows 2000 to Windows 10, with all service packs and hotfixes, all are
supported by WinLock.

e WinLock is widely used.
Hundreds of thousands of copies of WinLock have been downloaded by computer users
from virtually all countries of the world.

¢ WinLock will save you hours of learning time.
You don't have to learn how to use the Group Policies, user groups, Access Control Lists,
privileges, and other built-in security features of Windows, because WinLock does the
hard work for you: its visual and intuitive user interface lets you manage the restrictions
with ease.

e WinLock is widely used.
Hundreds of thousands of copies of WinLock have been downloaded by computer users
from virtually all countries of the world.

e WinLock is not a toy.
WinLock is used by large corporations and small businesses, schools and police
departments, universities and correctional facilities, libraries and hospitals (to name a
few).

e WinLock is extensible.
You can fine-tune the access rules by creating appropriate security profiles.

¢ WinLock is actively maintained.
Since its first release, we've been continuously extending, enhancing, and improving
WinLock.



System requirements

e Any PC computer running Windows 2000 and higher.
e At least 15 MB of free space on the hard disk.
e A TCP/IP capable network (for remote administration).

e Web camera (for webcam snapshots).



Feature comparison for Windows editions

Some features and commands are available only on computers running the Windows Vista and
higher. The following table summarizes the main differences in operation of WinLock under
different editions of Windows.

Feature

Windows
2000 and XP

Windows Vista
and 7

Windows 8

Windows 10

Disable preview pane

and higher

Disable New Shortcut
wizard

Disable Address and
Search bar

UAC settings

Disable Start screen

Disable edge panels

Disable Windows 8 tiles

Disable Action Center
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Chapter 2. Basics

Installing WinLock

If you already have a previous version of WinLock running on your computer, you should
shutdown it before installing the upgrade.

To install WinLock:

e Log on as administrator.
e Follow the prompts to complete installation.
e Use /silent command line parameter to install in silent mode.

e Although you can change destination folder during setup, it is highly recommended to
install WinLock into default location under Program Files folder.

Note: at this point WinLock, although installed, in no way affects the operation of your
computer. To enable the protection you must run WinLock and use its commands to specify
how exactly you want your computer to be protected.

11



Configuring user accounts

If you are working in a multi-user environment and want to use WinLock under new restricted
user account, you need to configure system access permissions. To do this, you should move
this user account to administrators group, then log on under this account and run WinLock.

Finally, you can remove this account from administrators group.

Alternatively, under General | Protection click Fix button to adjust the access permissions

automatically (works in Windows XP and higher). User Account Control should be turned on. If

you are using Windows XP, administrator's password should not be blank.

If you don't see the Fix button, there is no need to configure the account.

Or, download Account Configuration utility from our website. Select account under Account
and click Proceed. Command line usage: aconfig.exe <username= or aconfig.exe all_users.

Later, you can apply the active settings to any user using Profile | Apply.

Windows XP

e Make sure you are logged on as administrator.
e Shutdown WinLock.
e Open Control Panel and click Users Accounts.

e Click Change an account and select "Restricted User".

Pick a task...
[=] Change an sccoun:
watie & N dcoount

] Chen ge Hhe vy users log on or off

or pick an account to change

Administrator i Restricted user

V' Compisber admiristrator Limited account
f 4. Password protected B Password protected

e Click Change the account type and select Computer administrator.
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Pick a new account type for Restricted user

(=) Comnputer adinstratory 0 Linibed

¢ Log on under Restricted User and run WinLock.

e Log on under Administrator account, and select limited account type for "Restricted

User" account.

Windows Vista and higher

e Make sure you are logged on as administrator.
e Shutdown WinLock.
e Open Control Panel and click Users Accounts.

e Click Manage another account and select "Restricted User".

Choose the account you would like to change

" 1 Admin Restricted user
i'- 1_ - j,, Admmastrator Standard user

e Click Change the account type and select Computer administrator.

Choose a new account type for Restricted user

Restricted user
Stamdard user

Standard user
Standard account users can wse most software and change system settings that
do not affect other users or the securnty of the computer.

@ Adrministraton
Fdrmimistators have complete access to the computer and can make any
desired changes. To help make the computer more secure, administrabors are
asked bo provide their paisward of confirmation before making changes that
affect other users.
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e Log on under Restricted User.

e Right-click WinLock icon in Start menu and click Run as administrator.

r} -+ P -ﬂlp;n.

acation

" Run as administrator

art Menu

Add to Quick Launch

Log on under Administrator account, and select standard user account type for

"Restricted User" account.

Windows 2000

e Make sure you are logged on as administrator.

e Shutdown WinLock.
¢ Open Control Panel and click Users and Passwords.

In Users and Passwords dialog select "Restricted User" account and click Properties.

s and Passwords E: =l

Users |Mvir-:ld|

L thas st bedons Do grank or ey USErS AC08E 10 your
rompuber, and o changs passwords and obher sstbngs.

¥ Usars must gnter 8 ussr name and password bo use bhis computer,

Wksers Fo this oomputer:
ﬂﬂdnmstr:t:r Sdministrators
e Guests

| e | G
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e In User Properties dialog select Group Membership tab and add this user to
administrators group.

FHHMI OTLIFOA AR Restrictsd User Profis 2] x|

Gersral  Group Membership

Whak lerved of access do you wank bo grant this user?

1 Standard user [Prowser Users Group)

Usirs can modf'y the compiter and irstal programs, but
carrot read files that belorg bo other users,

™ Restricted wser {Users G}
Users can operabe the compuber and save documents,
bt cannot irstall programs or maks potentialy damaging
changes to the system Files and ssthings.

| acinistratnes =
Administrators have complete and uneestricted
arosss ba the compubsrdomean

e Log on under Restricted User and run WinLock.

e Log on as Administrator, and select limited account type for "Restricted User"
account.



Deployment

WinLock should be installed on each computer that you want to restrict and control. WinLock
supports unattended (silent) setups. This provides an installation method that can be used from

within a batch file:

¢ Install WinLock in silent mode using /silent key, i.e. setup.exe /silent

e Include your .wlp security profile into the deployment batch file.

Then, start WinLock and use command-line parameters to apply security profiles:

o C:\Program Files\WinLock\winlock.exe - this will start WinLock.
o C:\Program Files\WinLockl\winlock.exe -cp <password> - creates password for WinLock.

e C:\Program Files\WinLock\winlock.exe -profile <.wip profile filename> <password> -
this will apply .wlp security profile.

e C:\Program Files\WinLock\winlock.exe -enable <password> - enables the protection.

Remote access

e Access via Remote Administrator is disabled by default. To enable it during installation,
install WinLock using /enableremote key, i.e. setup.exe /enableremote.

16



Remote Administrator

WinLock Remote Administrator, the centralized remote management solution. It helps quickly
configure remote WinLock clients via network, lock remote workstations, and apply security
profiles by means of easy-to-use interface.

Being a client-server application, Remote Administrator allows the administrator to control the
network installations of WinLock without leaving the computer. A free version is available for
Android devices.

By means of this tool, administrators can:

e manage WinLock settings on-the-fly,

¢ enable or disable protection,

e pause protection,

e send pop-up messages,

e shutdown, lock, or reboot the remote computer,
e scan network for active WinLock clients,

e capture snapshots of remote desktop or webcam,
e run programs or open files on remote clients,

e and more..

With comprehensive encrypted protocol, Remote Administrator allows fast and secure
communication between multiple machines and can be safely deployed in any environment.

For more information about WinLock Remote Administrator please visit our website at
http://www.crystaloffice.com.

17
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Checking for updates

We are committed to providing updates and improvements to our software, and delivering them
to our customers. You can use the Check for Updates to ensure that your copy is the most up-
to-date version available. Internet connection is required.

To check for updated software:

¢ In main menu, click Help.

e Click Check for Updates.

18



Uninstalling the software

To completely uninstall WinLock, you CANNOT simply delete all the program files. If you wish to
uninstall WinLock, follow these instructions:

Right-click on the WinLock tray icon and click Shutdown. Then enter the correct
password and click OK.

It is necessary to shutdown WinLock before uninstall it!
Click the Start menu from the taskbar and select Control Panel.
Click Programs and Features.

Select WinLock Professional from the list and click Uninstall button.

Confirm that you want to uninstall WinLock.

19



Chapter 3. Getting started

Overview

All WinLock commands are related to the following features:

e Restricting the access to system options.

e Locking system resources (applications, files, folders, etc.).
e Internet restrictions.

e Controlling how long others can use your computer.

e Monitoring the changes to the Windows shell.

e Remote administration.

The main window of WinLock looks like the following:

Protection Profile Tool 1 Help

Status
General WinLock is enabled and protecting your System.
L ] :
L Enable protection
Protecton .

Settings
Notifications Passweord

Leggng .
ﬁ Password BEEEEARIRISRS
Remate Administraton -

Confirm password SBEREEEEIREERS

D Password strength: 100%

&=, System

@ Internet Ulsers
[t}
Access )
@ Timer

Very Strong
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Numbers in this picture show the main parts of the program:

1. Main menu.
2. Shortcut bar.
3. Application area.

The Shortcut bar displays folders: General, System, Internet, Access, and Timer. Clicking on a
folder makes that folder active and displays the icons it contains. Selecting an icon changes the
page displayed in the application area.

21



Launch WinLock

First of all, a word of warning: WinLock is a powerful tool and should be used responsibly.
Using it thoughtlessly, you can inadvertently make your computer inaccessible. For example, it
is very easy with WinLock to prevent access to the desktop, and make Windows start with a
blank screen after you reboot.

B & ) 436pm [ ]

To launch WinLock click Start button then select Programs and click WinLock. After you start
WinLock its icon appears in the system tray near the clock. It is good idea to use Run as
Administrator command to run WinLock for the first time.

Note: by default, WinLock loads automatically on Windows startup.

22



Enable WinLock

After installation, WinLock starts in Disabled mode. It means that all WinLock protection options
are disabled. If WinLock is disabled, the tray icon is grayed.

B & ) 436pm [ ]
e Right-click on the WinLock tray icon and select Enable item.

e You will be prompted for the password. Enter the correct password and click OK. Now
WinLock is enabled.

e To disable WinLock right-click on the WinLock tray icon and select Disable item.

23



Tray pop-up menu

T Tray pop-up menu allows you to access the main WinLock functions. Right-click on the
WinLock tray icon to open pop-up menu.

Pop-up menu contains the following commands:

e Open WinLock - opens WinLock main window.

¢ Instant Lock - provides access to applications previously locked by Instant Lock.
e Enable - enables WinLock protection.

o Disable — disables the protection.

e Help - displays the help contents page for WinLock.

e Pause - pauses protection.

e Lock - locks workstation.

e Shutdown - disables all forms of WinLock protection and unloads it from memory.

e Shutdown Windows - shutdowns Windows.
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Enter WinLock password

First, you should enter new WinLock password. Right-click on the WinLock tray icon and click
Open WinLock. If you are using WinLock for the first time, you will not be asking for the
password.

In General click Settings, enter password in Password and re-enter this password in
Confirm password. Then click OK.

Letters in password must be typed using the correct case. Make sure that Caps Lock is not
accidentally on.

REMEMBER THIS PASSWORD! You will be unable to configure or shutdown WinLock without it!

25



Pause protection

e Pause for the specified time: mode of resuming the protection, which automatically
enables protection in the specified time interval.

e Pause until reboot: enables the protection after reboot of the operating system.

o Disable protection: enables protection only if you decide to resume it.

26



Shutdown

To shutdown WinLock, right click on the WinLock tray icon and click Shutdown. Or, open main
window and click Shutdown in Protection menu (in this case you will be able to select the
shutdown options).

Shutdown WinLock - disables all forms of WinLock protection and unloads it from
memory.

Shutdown Windows - ends your session and shutdown Windows so that you can
safely turn off power.

Restart Windows - ends your session, shutdown Windows, and starts Windows again.
Logoff current user - ends your session, leaving the computer running on full power.
Lock - locks the computer and opens Windows Welcome Screen.

Sleep - puts the computer in a low-power state.
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Guest password

Guest password allows users to unlock the system locked by WinLock without entering the
master password. Guest password can't be used to shutdown WinLock or change protection
settings. Select One-time password to reset the guest password after the first use.

28



USB key authentication

USB key authentication allows to access WinLock in a secure way by USB flash drive. It turns
any USB flash drive into protection key for WinLock. WinLock uses USB flash drive serial
number, so the key cannot be duplicated. Available in WinLock Professional running under

Windows Vista and higher.
To enable USB key authentication:

e In main menu, click Protection and select USB Key.

e Connect up your USB flash drive. The program will automatically identify the connected
device.

e Select you USB flash drive and click OK.

e To disable USB key authentication, click Reset.

To use USB key authentication:

e Connect up you USB flash drive.

e Open WinLock password prompt and click USB Key icon.

WinLock

Password

n Enter password to open WinLodk,

) Cancel
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Password recovery

The Password recovery can help you restore control of WinLock if you ever forget its password.
To recover your password, right-click WinLock tray icon and enter your license key in the
password prompt. Be sure to enter the key EXACTLY as it appears in the message that you
have received from us after you have purchased your license. This step is necessary to prevent
unauthorized users from using the Password recovery to disable the protection performed by
WinLock.

If you disabled WinLock tray icon and can't remember your hot key, try to do the following:

e Try to use the default F11 hot key to open WinLock,
e orclick Start | Run and run WinLock with -open command line parameter,

e Or use this utility to restore the tray icon: http://www.crystaloffice.com/showicon.exe
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Password generator

Use Password Generator to create highly secure passwords that are difficult to crack or
guess. To start create secure passwords, in Tools menu click Password Generator. Then,
select the criteria for the passwords you need, and click Generate. Click Copy to place the
password to clipboard. Remember, the more options you choose, the more secure the

passwords will be.
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LockBox

You are likely to have confidential documents on your computer, which you may want to
encrypt. WinLock uses a very strong Blowfish crypto-algorithm, to protect data.

To open LockBox, In Tools menu click LockBox.
To encrypt a file, you will have to do the following:

e Select Encrypt a file.

e Enter the name of the file that you want to encrypt.

% You can select multiple files by clicking on a file names while holding Ctrl key in Open
dialog.

e Enter the password in Password, and re-enter it in Confirm password.
To use current WinLock password for encryption, select Use WinLock password.

e Select, whether you want to delete the source file after encryption.
¢ Click the Next button to encrypt the file.

e Your file is now encrypted and can be decrypted only by those who possess the
password for that particular file.

To decrypt previously encrypted file, you will have to do the following:

e Select Decrypt a file.

e Enter the name of the file that you want to decrypt.

e Enter the password in Password.

e Select, whether you want to delete the source file after decryption.

e Click the Next button to decrypt the file.

32



Instant Lock

With Instant Lock you can hide any program or window on your screen with a simple hot key
combination. Hidden windows can be restored with the correct password only. To activate
Instant Lock, select Enable Instant Lock under General | Settings. Then, enable WinLock
protection.

e Whenever you want to lock a window, press Ctrl+Space. The active window will be
hidden. This can be an application window, dialog, or even desktop!

¢ To unlock a window, right click WinLock tray icon, select Instant Lock and click on a
window you want to restore. Then, enter WinLock password. Or, open WinLock and

select Instant Lock under Protection menu.

%* If you shutdown WinLock, all hidden programs will be restored automatically.
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Screen capture

Use Screen capture to create snapshots of your screen or web camera at regular intervals. To
open screen capture, in Tools menu click Screen Capture.

e Enable screen capture - select to turn Screen capture on.
e Interval - select the frequency of the timer. It can be from 2 to 60 minutes.

¢ Maximum - the maximum number of screenshots that WinLock holds. Old screenshots
are replaced with new ones.

e Quality - screenshot quality (/ow, medium, or high).

e Source - source device (screen, web camera, or both). If you select Screen and
webcam option, webcam snapshot will be taken right after the desktop one.

e Use First (Home), Last (End), Previous (PgUp) and Next (PgDn) buttons to
navigate through snapshots.

e To view screenshot, double click the thumbnail, or click Items and select View.

e To save the screenshot to a JPEG file, double-click the thumbnail, then right-click the
screenshot and select Save As.
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Chapter 4. Settings

Configure WinLock

Normally, WinLock is displayed as an icon near the system clock.

Right-click on the WinLock tray icon and click Open WinLock. You will be prompted for the
password. To adjust various WinLock settings, select an icon in the Shortcut bar. The
corresponding page will be displayed in the Application area that takes up the main portion of
the window area.

Tip: to apply all the selected settings immediately and restart Windows shell, in Protection
menu click Apply Settings.

Profiles

You may save WinLock settings to a file and open them later using the appropriate command in
Profile menu. Using the profiles lets you to switch between different protection schemes easily.
If you want to save current password in the saved profile, select Save Password in Settings.
Also, profiles can be loaded on-the-fly from the command line without opening configuration
window. For example, run winlock.exe -profile internet.wlp <password=> (note that
WinLock should be already loaded) to automatically apply internet.wlp profile.

To apply the profile to the other user, click Profile button and select Apply.

35



WinLock comes with a number of profiles ready for you to use. These predefined profiles

located in Profiles folder and optimized for a particular purpose, defined by the profile name:

browsers.wlp: blocks most modern browsers.
dialogs.wlp: blocks system dialogs.
games.wlip: blocks default games.

install.wlp: disables software installation.
internet.wlp: stops internet-related applications.

kiosk.wlp: turns on kiosk mode. This mode allows the use of the one specific
application, while disabling access to other programs and system resources. The

shortcut to this application should be added into Start\Programs\Startup folder.

media.wlp: disables multimedia applications usage.

msg.wlip: avoid users from running common instant messengers.

p2p.wlp: avoid users from running common file sharing peer2peer applications.
system.wlp: restricts access to system settings.

websites.wip: restricts access to adult web content.
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Protection

This page allows you to configure protection options.

e Enable protection - clear this check box to temporarily suspend all forms of WinLock
protection.

e Password - here you can enter or change WinLock password. It is not recommended to
use as a password anything that is easy to guess (for instance, surnames, names, dates

of birth). To ensure a secure password, use upper and lower case characters, figures
and symbols.

This password grants you access to WinLock settings. Be sure to select one that you will

remember, but that no one will guess.

Users

Here you can create different protection schemes for each user in a multiple-user environment.

For each one, WinLock will activate only the selected restrictions. Moreover, it is possible to
suspend all forms of WinLock protection for the specified user.

Let's say you have user account called "Restricted User" and you want to apply specified
security restrictions to this account.

e Select Personal security settings for each user check box.

¢ Log on under the "Restricted User" account. You will see Restricted User under
Current user.

e Select security restrictions that you want apply to this user and click OK.

%* To delete all previously created profiles, click Reset Profiles button.
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Settings

This page allows you to adjust general WinLock parameters.

e Turn on protection on startup - if you select this check box, WinLock will be
automatically enabled on startup, even if it was previously disabled.

e Prompt for the password on startup - if checked, this option causes WinLock to
prompt for the password on startup in order to use the computer.

Note: this option disables startup notification.

e Enable Shutdown Windows menu - select to enable Shutdown Windows item in
WinLock tray popup menu. By clicking this item it will be possible to shutdown or restart
Windows without opening WinLock main window. This is useful if you have disabled the
Start button and need to shutdown your system without entering WinLock password.

e Save password in settings profile - select this check box if you want to save
password in the settings profile.

¢ Show password prompt on top of the other windows - select to prevent password
prompt and unlock prompt dialogs from losing keyboard focus.

e System monitoring - if you select this check box, WinLock will continually monitor
user activity to prevent changes that may affects WinLock security options.

¢ Hide tray icon - select this check box to disable WinLock tray icon. Note that pressing
the Properties hot key will be required to show WinLock. Or, open folder where
WinLock was installed and run winlock.exe file with -showicon parameter.

¢ Unload protection - prevents the ability to unload WinLock using third-party task
managers.

o Self-protection - self-protection is used to enable the application's mechanism that
protects its own files on the drive and its processes in memory. Note: you must restart

your computer to make effect.

e Ask for password to run restricted executables - select to run the restricted
executables after entering the correct password.

e Enable Instant Lock - select to enable Instant Lock feature.
¢ Automatically check for updates - automatically checks for program updates.
e Use system window frames - use the default system theme to paint windows frame

and caption.
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Priority - this setting lets you adjust WinLock's use of machine resources High priority
improves the protection but may slightly slow down the computer. If you do not use
System Monitoring, or Block Windows feature, you can select Low priority.

Language - selects the program language.

Instant Lock hot key - select the hot key that activates Instant Lock (Ctrl+Space or
Shift+Space).

Properties hot key - select the hot key that opens WinLock main window.
Protection hot key - select the hot key that enables or disables WinLock protection.

Lock hot key - select the hot key that locks the computer.

* To setup a hot key, click in the hot key box and press the desired keys, the box will
update with the names of the keys you wish to use.
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Notifications

Controls notification messages appearance.

¢ Notification when application or site is blocked - this warning message will be
displayed each time application of website is blocked.

¢ Notify on startup - when timer is turned on, WinLock shows "Time remaining"”
messages on the system startup.

¢ Show timer notification - displays notification messages before shutting down the
system.

e Fade effect - controls the fade-in animation of notification messages.

¢ Show notifications as popup messages - select this check box to display
notifications as pop-up hints.

Sounds

Various sound effects. Sound is played even if the corresponding visual notification is
disabled.
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Logging

Logging feature monitors changes to the Windows shell, writes these changes to the log file,
and optionally sends e-mail reports or notifications to remote administrator.

Click on the check box to enable or disable logging for the specified event. If the check box is
checked, then the event will be logged.

Note: logging feature doesn't monitor console applications.

File created - a new file was created, or website opened in Internet Explorer.
File changed - an existing file was changed.
File renamed - an existing file was renamed.

File deleted - an existing file was deleted. Note: files that are sent to the Recycle Bin
are excluded from logging on some operating systems.

Folder created - a new folder was created.

Folder renamed - an existing folder was renamed.

Folder deleted - an existing folder was deleted.

Folder updated - an existing folder content was updated.
Folder shared - an existing folder was shared.

Folder unshared - an existing folder was unshared.

Media inserted - a new media was inserted into the drive.
Media removed - a existing media was removed from the drive.

WinLock started - WinLock was started (this event also logs the hame of the current
user).

Status changed - WinLock was enabled, disabled, shutdowned, or the active session
has been closed.

Computer locked - the access to computer was locked by WinLock.
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e Website blocked - the restricted website was blocked.
e Executable blocked - the disabled executable was blocked.
e Application blocked - the disabled window was closed.

e User logged - an user has been logged on using fast user switching, or the active
session has been closed.

e Application launched - an application has been launched.

Click Select All or Select None to enable or disable logging of all events.
Click View Log to view events log.

E-mail Report - click to configure e-mail notifications.

Limit logging

Select Limit logging to set the limit on events to be logged. For example, if user deletes 500
files and limit is 10 events, only first 10 files will be logged. This is useful, when you don't need
to know every file that was deleted, only that one or more files was in fact deleted. This is
useful, when you don't need to know every file that was deleted, only that one or more files
was in fact deleted

File size

Specified the maximum size in kilobytes to which log file can grow.
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E-mail reports

WinLock can inform you about user activity (created files or folders, blocked websites, launched
applications, etc.) via e-mail. To activate e-mail reports, click General/Logging and enable
logging. The report will be sent only when there was an activity.

e Send every - select, how often you want to be notified.
e Send to - specified the e-mail where to send the reports.
e SMTP server - the address of your outgoing SMTP server (e.g.: smtp.gmail.com).

e Port - contains the port of the SMTP mail host to connect to. This value is usually equal
to the standard SMTP port 25.

e Username - the SMTP user name for access to your mailbox on the server. Usually, it is
the same as your e-mail address, or the part of the account's e-mail address before the
"@" symbol. For example, if the e-mail address is john@somedomain.com, the user's
name will be john.

e Password - the password for logging on to the SMTP server.

e Server requires secure connection (SSL) - select to enable SSL encryption.

o Attach desktop screenshot - select to attach desktop screenshot to report.

e Test - before you activate e-mail reports, you should, in every case, click this button to

make sure that your entries are correct and you are able to receive e-mails. If the
sample report is not delivered, please check your settings and the spam folder.
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Google Mail settings:

e User: your Gmail e-mail address

e Password: your Gmail account password

e SMTP server: smtp.gmail.com

e Port: 465

e Server requires secure connection (SSL): checked

Microsoft Live Mail settings:

e User: your Live Mail e-mail address

e Password: your account password

e SMTP server: smtp.live.com

e Port: 25

e Server requires secure connection (SSL): checked

AOL settings:

e User: your AOL e-mail address

e Password: your AOL account password

e SMTP server: smtp.aol.com

e Port: 587

e Server requires secure connection (SSL): checked
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Remote administration

This page provides access to WinLock Remote Administrator connection properties.

WinLock Remote Administrator, the network security solution for TCP/IP networks. A new
security application that will make networks safer and administrators' life easier. Remote
Administrator provides remote configuration of WinLock and WinLock Professional clients by
means of a comfortable and easy-to-use interface.

WinLock Remote Administrator enables the administrator to control the network installations of
WinLock without leaving the computer. By means of a fast and secure communication
technology, administrators can manage WinLock settings, enable or disable each copy of
WinLock separately, send pop-up messages, take remote desktop screenshots, and much
more..

¢ Enable remote administration - select to enable remote control of this copy of
WinLock.

e Port - identifies the port number used by WinLock Remote Administrator for connection
to this computer. The port number must be identical to the value that was entered in
the Remote Administrator's host list.

e Use alternative password - to gain the access to the remote host, Remote
Administrator sends the access password with each command. Clear this check box if
you want to use master password for remote control, otherwise enable this option and
enter an alternative password in Password.

o Accept commands from specified address only - select this check box if you want
to enable remote control from specified computer only, otherwise WinLock can be
controlled from any network computer.

o Allow replies - select to enable the reply button. Replies will be shown under
notifications in Remote Administrator.

e Send notifications - select to send notification to remote server. Notifications are
selected on Logging page.

¢ Pin incoming messages - unpinned messages are closed automatically in 30 seconds.
A pinned message remains open and can be closed manually only

¢ Remote address - name or IP address of remote administration server. Enter if you
want to send notifications to remote administrator. You can use multiple addresses that
should be separated by comma or semicolon.

% WinLock uses port 4000 for remote notifications, so this port should not be blocked by
firewall software.
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Security

This page provides access to the system security options.

General

Here you can adjust general security options.

Disable Registry Editor - disables the Windows Registry Editors, regedt32.exe and
regedit.exe.

Disable Display Properties - prevents Display in Control Panel from running.
Disable Windows Update - select this check box to prevent users from connecting to
the Windows Update website and remove the Windows Update hyperlink from the Start
Menu and from the Tools menu in Internet Explorer.

Disable Control Panel - prevents Control Panel from running.

Disable shortcuts - locks shortcuts.

Disable New Shortcut wizard - disables the ability to create new shortcuts in
Windows Vista and higher.

Disable programs on Settings menu - prevents Control Panel, Printers, and Network
and Dial-up Connections from running, and removes the corresponding menu items
from Start menu.

Disable Programs and Features - removes Programs and Features and Add/Remove
Programs from Control Panel and menus.

Disable command prompt - disables the ability to run the interactive command
prompt, cd.exe.

Don't save settings on exit - prevents users from saving certain changes to the
desktop. Users can change the desktop, but some changes, such as the positions of
open windows and the size and position of the taskbar, are not saved when users log
off.
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Advanced

An extra security options.

Disable Task Manager - disables the ability to start Task Manager to view processes,
applications running, and make changes to the priority or state of the individual
processes.

Disable Lock Computer - prevents users from locking the system.

Disable My Computer - removes My Computer icon from desktop and Start menu.
Disable system properties - disables System properties dialog.

Disable safe mode - disables the ability to boot in safe mode. Safe mode is a special
diagnostic mode of Windows, which you can use to troubleshoot problems with your
computer. When you reboot your computer in the safe mode, only the core Windows
components are loaded and activated. We DO NOT recommend enabling this option,
because you may not be able to use the safe mode to troubleshoot the problems. Use
this option at your own risk. Note: this option disables safe mode in Windows 2000 and
higher. To disable safe mode in Windows 98, use Boot feature.

Disable Ease of Access - disables Ease of Access button on logon screen.

Lock Clipboard - locks Windows Clipboard.

Disable Change Password - disables the Change Password button on the Windows
Security dialog box (which appears when you press Alt-Ctrl-Del).

Hide Fast User Switching - removes Switch User option from the Alt+Ctrl+Del
screen.

Disable Computer Management - disables Computer Management console.

Disable Run as Administrator - removes Run as Administrator item from Explorer
context menu.

Disable Windows Installer - disables Windows Installer. No installs are allowed
including repairs, reinstalls, or on-demand installations.

Force system shutdown - forces Windows to close all tasks and applications while
shutting down (available in Windows 8 and higher).

Disable Timeline - disables Windows 10 timeline feature.
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Explorer and Windows

This page includes a group of options that restrict Explorer and windows-management
commands.

¢ Hide ribbon and main menu - select to remove Windows Explorer main menu or
ribbon. This options also hides the Quick Access toolbar in Windows 8 and higher.

e Hide Folder Options menu - removes the Folder Options item from all Windows
Explorer menus.

e Disable right-click menu - select this check box to disable Explorer right-click context
menu.

¢ Hide search button - removes search button from Windows Explorer under Windows
2000 and XP, or removes search and task view from Windows 10 task bar.

e Disable Map/Disconnect - select this check box to remove the Map Network Drive
and Disconnect Network Drive options.

¢ Disable Address and Search bar - disables Explorer Address bar and Instant Search
box (available in Windows Vista and higher).

o Disable preview pane - disables the preview pane in Open dialogs. Available in
Windows Vista and higher.

¢ Disable Close command - disables the ability to close windows.

¢ Disable Move command - disables the ability to move windows.

¢ Disable Resize command - disables the ability to resize windows.

o Disable Restore command - disables the ability to restore windows.

¢ Disable Maximize command - disables the ability to maximize windows.
o Disable Minimize command - disables the ability to minimize windows.

¢ Disable main menu - prevents user from being able to open main and window menus
(may not work with some programs).

e Hide libraries - select to remove user libraries from Explorer (changes will take effect
after restart).
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Start menu and Taskbar

Click on the check box to show or hide Start menu items. If the check box is checked, the
corresponding menu item will be shown in Start menu. If the check box is unchecked, the
corresponding menu item will be removed from Start menu.

¢ Hide recent programs - removes frequent programs list from the Start menu.
¢ Hide all programs - removes the More Programs list from the Start menu.

e Hide user name - remove user name from Start menu (Windows XP only).

o Disable drag and drop - disables drag and drop on the Start menu.

e Disable Start menu - hides Start menu but retains the access to Start button right-
click menu (Windows 10 only).

e Disable Start screen - disables Windows 8 Start screen.
e Disable Start button - hides the Start button.

o Hide Switch bar - select this check box to hide the portion of the taskbar where you
find all the buttons of active applications.

e Lock taskbar - restricts users from making any changes to taskbar position.

o Hide taskbar - select to hide the entire taskbar, including Switch bar, system tray, and
Clock. The Auto-hide the task bar option in taskbar properties should be turned off.

o Hide tray items - select to hide the system tray icons.

e Disable right-click menu - removes the context menu for the taskbar, including the
Start button, selection bar, and clock.

e Lock hidden icons - disables Show hidden icons button on the taskbar.

¢ Disable taskbar customization - this option will lock the option of pressing the
Property from the mouse right click on the taskbar.

o Lock taskbar's toolbars - prevents users from adding, dragging, dropping and closing
the taskbar's toolbars.

¢ Disable taskbar redock - prevents users from moving the taskbar.
o Disable taskbar resize - disables the ability to resize the taskbar.
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e Disable Start screen - disables Windows 8 Start screen.
¢ Disable pinned apps — removes pinned programs from taskbar.
e Disable Action Center - disables Windows 10 Action Center.

¢ Disable edge panels and swipes - disables hot corners and popup edge panels (such
as Charm Bar and Switcher) in Windows 8 and higher. To disable Windows+C hot key
that invokes Charm, disable the Windows key under Mouse and Keyboard. To restore
the access to hot corners restart or re-login is required.
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Desktop

Block desktop - select this check box to hide all desktop icons and shortcuts.

Disable Active Desktop - select this check box to disable Active Desktop and prevent
users from enabling it.

Read-only desktop icons - select this check box to disable the ability to rename
desktop icons in place. To completely disable desktop icons modification, use this option
in combination with Disable Explorer context menu.

Disable HTML wallpaper - permits only bitmap images for wallpaper.

Disable changing wallpaper - disables all options on the Background tab of Display
in Control Panel. As a result, users cannot add or change the background design of the

desktop.

Hide Recycle Bin - removes the Recycle Bin icon from the desktop. You must restart
your computer to make effect.

Hide Network - removes the Network icon from the desktop.
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Mouse and keyboard

Hot keys

Click on the check box to enable or disable the specified system-wide hot key (such as Alt-Esc,
Alt-Tab, Ctrl-Esc, etc.). If the box is checked, then the corresponding hot key will be blocked.

Click Disable All to block all hot keys or Enable All to enable.

Tip: you cannot disable Alt+Ctrl+Del directly. However, you can disable all items under
Alt+Ctrl+Del screen (Lock Computer, Change Password, Fast User Switching, Log off and Task
manager). This will make this hot key useless.

Tip: to disable Flip 3D (Windows+Tab key) feature in Windows Vista and 7, use Disable
Windows key option.

Mouse
Click on the check box to enable or disable the specified mouse button.
Click Disable All to block all buttons or Enable All to enable them.

Note: you will be able to use mouse buttons in the system tray in order to access WinLock tray
icon unless Hide tray icon option is turned on.
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Drives

General

Click on the check box to enable or disable the display of the drive in My Computer and
Explorer. If the check box is checked, then the drive will be shown in My Computer and
Explorer if the drive exists on the computer. If the check box is unchecked, then the drive will

be removed from My Computer and Explorer.

e Block network drives - select to disconnect network drives.

Removable storages

¢ Block access to removable storages - select to block removable storage devices
(DVD ROMSs, USB Drives, etc.)

o Exclusions - volume labels that will be excluded from blocking. Label must be
separated by comma or semicolon. Example: USB_1;BACKUP;SYSTEM. Available in

WinLock Professional only.
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User Account Control

This page provides access to Windows Vista, Windows 7 and Windows 8 User Account Control
settings.

e Enable User Account Control - enables User Account Control.

e Enable Safe Desktop mode - this setting determines whether the elevation request
will prompt on the interactive users desktop or the Secure Desktop.

UAC Prompts

This setting determines the behavior of the elevation prompt for standard users and
administrators.

¢ None - elevate privileges automatically without prompt.

e Prompt for credentials - an operation that requires elevation of privilege will prompt

the user to enter an administrative user name and password.

e Prompt for consent - an operation that requires elevation of privilege will prompt the

user to select either permit or deny.
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Internet Explorer

This page includes a group of options that control Internet Explorer restrictions.

e Disable New command - disables New Window command on File menu.
¢ Disable Open command - disables Open command on File menu.
e Disable Save command - disables Save and Save As on the File menu.

¢ Disable Save As dialog - prevents user from being able to select download folder by
not displaying the Save As dialog box when a file is downloaded.

o Disable Close command - prevents user from being able to close Internet Explorer.
o Disable printing - removes Print and Print Preview from the File menu.

e Disable Find Files - disables the Find Files command.

¢ Disable file download - disables the ability to download files.

o Disable Full Screen mode - disables the Full Screen option.

¢ Disable Windows 8 tiles - always open the desktop version of Internet Explorer
(Windows 8 only).

¢ Disable View Source command - disables the ability to view the page source.

o Hide Favorites - hides Favorites menu, and disables adding to adding to favorites, or
organizing favorites.

e Disable internet options - disables Internet Options on the Tools menu.

¢ Disable right-click menu - disables right-click context menu.

e Disable toolbars options - disables adding, removing, or moving toolbars. For
example, if you want to disable the ability to show Address Bar in both Internet Explorer
and Windows Explorer, you should open Internet Explorer, hide Address Bar (View |
Toolbars | Address Bar) and then select Disable toolbars options check box.

e Hide navigation buttons - disables the Forward and Back navigation buttons.

e Disable History bar - hides the History bar.
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Disable Folders bar - hides the Folders bar.

Disable Address and Search bar - disables Address bar and Instant Search box in
Internet Explorer 7 and above.

% Some of these options may affect Windows Explorer.

Disable Tools - disables Home, Favorites and Tools buttons in Internet Explorer 9 and
higher.

Disable InPrivate browsing - if selected, users cannot open web pages in private
mode.

Restricted Sites - specifies, whether restricted websites will be closed or redirected.
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Browsers

This page includes a group of options that control Google Chrome and Microsoft Edge. Available
in the Professional edition of WinLock.

o Disable Full Screen mode - disables the full screen mode in which all Google Chrome
Ul is hidden and only web content is visible.

e Disable bookmarks - if selected, bookmarks cannot be added, removed or modified.
Existing bookmarks are still available.

e Hide bookmarks bar - if selected, users will never see the bookmark bar.
o Disable developer tools - disables the Developer Tools.

o Disable translate - disables the integrated Translate service.

o Disable printing - disables printing.

o Disable Incognito mode - if selected, users cannot open web pages in
incognito/InPrivate mode.

o Disable Password Manager - disables saving passwords to the password manager.
o Disable End Process command - disables ending processes in Task Manager.

o Disable browser history - disables saving browser history.
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Trusted sites

This page provides access to the list of trusted websites.

Use this page to list the only websites that may be accessed. For example, add .edu into the
trusted sites to allow access to all .edu websites. All other sites (regardless of the keywords
they contain) will be unavailable.

Note: the Inline AutoComplete option in browser settings should be turned off.
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Restricted sites

This page allows you to enter keywords or site address that can terminate web session. The
Professional edition of WinLock not only checks the address of the site, but also scans the
entire page, including the hidden meta-tags for any prohibited words. For example, if you
define "sex" as a keyword, any website contains this word will be prohibited. This makes
possible to prohibit access to questionable websites - notably for public-access computers in
schools and libraries. You can use * and ? wildcards to filter website content. A question mark
matches any single character. An asterisk matches any number of occurrences of that string
followed by any characters.

% Click Items | Import to import keywords from .txt file.
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Windows

This page provides access to the Block Windows feature.

Block Windows can block any selected window or dialog, such as My Computer, Control
Panel, Internet Properties, etc. For example, if you want to disable the ability to open My
Documents window click Add button and enter My Documents in Caption.

Note: the caption is the title of the application while running it and not the application name!
Look at the text in the application top line while running it and enter it in WinLock caption list.

* Use Find Window button to list all visible windows.

* Caption may contains * and ? wildcards. A question mark matches any single character. An
asterisk matches any number of occurrences of that string followed by any characters. For
example, bo* matches bot, bo and boo but not b. So, if you want to block all windows with a

caption that begins, for example with a Internet word, you can use the following string:
Internet>.
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Executables

e Ask for password to run restricted executables - select to run the restricted
executables after entering the correct password.

¢ Block unsigned executables - block executable files with no digital signature. Digital

signature confirms the software author and guarantee that the program has not been
altered or corrupted since it was signed.
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Trusted executables

This page provides access to the list of trusted executable files. Use this page to list the only
executables that may be accessed. All other executables (except Windows core components)
will be unavailable.

% You can use * and ? wildcards. A question mark matches any single character. An asterisk
matches any number of occurrences of that string followed by any characters.
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Restricted executables

Here you can block application by the executable name or version info. For example, the
following application name would be used to close the Internet Explorer when someone tries to
open it: iexplore.exe. File info contains version and copyright information about the file
(company name, product name, comments, etc.) To read version information, right click the file
in Windows Explorer and select Properties | Details. For example, each software product
created by Adobe Systems contains word Adobe in version information. So, you can use the
following string to disable the ability to open Adobe software at all: *Adobe*. With executable
blocking you can disable nearly all software installation packages. To do this, add *setup* and
*install* into the File info.

% Both file name and version info may contain * and ? wildcards. A question mark matches
any single character. An asterisk matches any number of occurrences of that string followed by
any characters.

% Select Ask for password option on the settings page to run the restricted executables
after entering the correct password.
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Files

This page provides access to the Lock Files feature. This feature is similar to restricted
executables except it can lock any file, but not only applications.

Blocked files can't be opened for viewing or editing. Click Add button and enter file name in
File. Or, you can drop the selected files from Explorer onto the locked files list. Also, you can
use this feature to block any selected application. For example, if you want to disable the ability
to open Internet Explorer, add the full path to its executable file c:\Program Files\Internet
Explorer\iexplore.exe into the locked files list.

Check-mark at the left of the file name controls file protection mode:

e Select the check-mark to lock the file.
e Remove the check-mark from a file name to prevent the file from being locked.

e Select Read-only access to allow read-only access to the file.

64



Folders

This page provides access to the Lock Folders feature.

You can select folders you want to disable. These folders can't be opened, renamed or deleted.

Click Add button and enter folder name in Folder. Or, you can drop the selected folders from
Explorer onto the locked folders list. Select Allow access to folder content to retain the
access to folder content.

% You can't lock folder if it is already opened by other application.

% You can disable the access to the entire disk. For example, if want to disable the access to
drive D, add D:\ string to the locked folders list. This will prevent the access to this drive,
including all files and folders located on it.

65



Timer settings

Timer controls how long others can use your computer. Once that limit is reached, Windows is
summarily shut down.

Enable - select to enable timer.

Restart timer - if elected, WinLock will reactivate the timer with a new value. This
check box is disabled when timer is inactive.

% When enabled, WinLock displays the remaining time as a part of the tray icon hint.

WinLock
Status: Enabled

Time Remaining: 02:30

B 1 4y 43%6pm [ ]

Countdown timer - select this option to start timer in countdown mode. Then, specify
how long your computer will be available (for example, 3 hours and 45 minutes daily).

Time range - specify the time range when your computer will be available (for
example, from 9:00 am till 16:00 pm). All attempts to change the system time will be
blocked.

Shutdown - shuts down the system.
Logoff - shuts down all running processes and logs the user off.
Lock - locks the computer and opens the password prompt.

Lock after reset - select this box if you want to lock Windows after incorrect shutdown
(for example, after pressing the Reset button).

Disable timer after unlock - select this check box if you want to turn the timer after
unlock the computer.

Reset timer daily - this option allows you to limit daily computer usage. When
enabled, WinLock unlocks the computer for a certain period of time, once in a day. Do
not attempt to adjust system date and time while this mode is active! Otherwise, the PC
will be locked. It is also recommended to disable Internet time synchronization
option.

%* This option is unavailable in time range mode.
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Show countdown timer - displays onscreen countdown timer (available in WinLock
Professional only).

Unlock prompt - specifies how long WinLock shows the unlock dialog that prompts for
the correct password on the startup.

% To lock the computer immediately, in Protection menu select Lock.
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Chapter 5. Tips and features

Disable file download

To disable the ability to download files from websites add File Download dialog into the
blocked windows list.

e Open WinLock and select Access | Windows.

¢ Add File Download caption into the blocked windows list.

% Under WinLock Professional, use Disable file download option.
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Disable file rename

To disable the ability to rename files:

e In Windows Explorer, click Folder Options, and select Single-click to open an item.
e Under Explorer and Windows, select Hide menu and Disable right-click menu.

e Under Mouse and Keyboard, disable F2 key.
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Block Web browser

The best way to block Web browser is to add its executable file into the blocked files list.

e Open WinLock main window and select Access | Files section.

e Add the full path to Web browser executable file into the locked files list. For example,
c:\Program Files\Internet Explorerl\iexplore.exe or c.:\Program Files\OperalOpera.exe.
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Disable the End Process command

If you want to disable the ability to end processes from Windows Task Manager, but do not
want to disable the Task Manager itself add Task Manager Warning into the blocked

windows list.

e Open WinLock main window and select Access | Windows section.

e Add Task Manager Warning into the blocked windows.
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Disable Ctrl+Alt+Del

You can disable all buttons on Windows Security screen. This will make Ctrl+Alt+Del useless.

e Under System | Security, select Disable Lock Computer, Hide Fast User
Switching, Disable Change Password, and Disable Task Manager.

e Under System | Start Menu and Taskbar, disable Log off and Shutdown.
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Desktop icons protection

If you want to protect desktop icons but do not want to hide them, you can use Lock Files
feature:

e Open Access | Files section.
e Click Browse button.
e Select Desktop folder and add all *.Ink files into the blocked files list.

e For each file, enable read-only access.
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Remove buttons from the taskbar

To remove Cortana, Task View, and People from the taskbar:

e Right-click on any empty part of the taskbar and uncheck Show Cortana button,
Show Task View button, and Show People on the taskbar.

e Open WinLock and select System | Start Menu and Taskbar.

¢ Select Disable right-click menu and Disable taskbar customization.

74



All settings are reset after restart

If you lose all settings after reboot do the following:

e Shutdown WinLock.

e Right click WinLock icon in Start menu and select Run as Administrator.
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Kiosk mode

Kiosk mode allows the use of the one specific application, while disabling access to other
programs and system resources. To enable kiosk mode:

e Add shortcut to the application into Start\Programs\Startup folder.
e In main menu, click Profile | Import.
o Select kiosk.wip profile.

e Enable WinLock.
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Command line parameters

WinLock accepts the following optional command line parameters:

-open - opens WinLock.

-enable <password=> - enables protection.

-disable <password=> - disables protection.

-password <password> <new password=> - changes WinLock password.

-cp <password=> - creates new WinLock password. Use this command to create
password right after installation.

-lock <password=> - locks the computer.

-shutdown <password=> - shutdowns WinLock.

-showicon - restores the tray icon.

-profile <profile file name> <password> - applies settings profile. You can use

this command right after installation when WinLock password is not created yet. In this
case you don't need to enter the password in command line.

These command line options do not specify the startup options, but affects the active instance
of WinLock. In other words, you should start WinLock first, and then use command line
arguments to control its behavior.
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Appendix A. Purchase and technical support

Purchase

You may try out WinLock without any costs for the period of 30 days. If you wish to keep on
using it after this period, you should purchase a license.

Registration gains access to the some advanced features:

e Lock desktop.

e Hide taskbar.

e Self-protection.

e Ability to lock unlimited number of files and websites.
e Lifetime license to the current version.

e One year of free upgrades.

e Free online technical and customer support.

WinLock is licensing on a per-computer basis. One license is required for each computer where
software is installed.

If you wish to become a registered WinLock user, all you need to do is make a payment via
online order page.

Online purchase available for all payment options, including Credit Card, PayPal, Fax, Check,
Wire Transfer, and Purchase Order.
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Technical support

Before you contact us, please do the following:

e Be sure that you're doing everything right. We all make mistakes sometimes: be
attentive.

e Look at the Help file: it may already contain an answer to your question.

e Visit WinLock home page in the Internet at http://www.crystaloffice.com. It's a good
chance that you'll find the newer version of WinLock there.

If you still have a problems with WinLock, or if you have questions or comments, please e-malil
to support@crystaloffice.com. Make sure that your message contains a valid return address. In
particular, be sure to remove the "anti-spamming" parts, if any, from your return address.

When reporting problems, please include the following information:

¢ Which OS are you running?
e WinLock version (see the "About" dialog).

o Description of the problem (as much detail as possible so we can duplicate the
problem).

We'll try to help you as fast as possible, usually in one or two business days.
Feedback

We welcome your opinion about our software. Your feedback is important to us in order to get
an idea of how to make our software a better product for you. So if you have a grand idea for a
new feature, or a better way of doing something, please drop us a note. Please visit the
WinLock home page to download the latest version and find out more about our software.
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